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K1 LEVEL 

UNIT – I 

1. ------- key is used for saving a document. 

      a) Ctrl + P 

       b) Ctrl + Q 

       c) Ctrl + R 

       d) Ctrl + S 

2. To go to the end of a line, press ------ key. 

       a) End  

       b)  Home 

       c)  Up arrow 

       d)  Down arrow 

3. ------- key deletes the character to the right of the cursor position. 

 a) Insert  

       b)  Del  

       c)  OVR 

       d)  Page up 

4. ------ key is used to get the previous actions done by the user. 

a) Ctrl + W 

       b)  Ctrl + X 

       c)   Ctrl + Y 

       d)  Ctrl + Z 

5.  Ctrl + B are used to ----- the text. 

       a)  Bold 

       b)  Italic 

       c)  Underline 

       d)  Bold and Underline 



6. Ctrl + V keys are used to ---- the text. 

 a) Cut 

       b)  Copy 

       c)  Save 

d)  Paste 

7. Crtl + H are used to -------  the text. 

a) Edit 

       b)  Find 

       c)  Replace 

       d)  Format 

8. F7 key is used to select the ----- command. 

       a)  Find and replace 

       b)  Spelling and Grammar 

       c)  Auto Correct 

       d) Auto Text 

9. To use Thesaurus, click ------- menu.  

 a) File 

       b)  Insert 

       c)  Tools 

       d)  Table 

10. To create a table in Ms-word use ----- command from Table menu.  

 a)  Insert  

       b)  Edit  

       c)  Row 

       d) Column 

UNIT – II 

11. The workspace area is a grid of -------. 

       a) Rows   



       b) Columns 

 c)  Rows and Columns 

       d)  Border 

12. Intersection of a row and column is called as ------. 

       a)  Cell 

       b)  Active Cell 

       c)  Current Cell 

       d)  Adjourned Cell  

13. To down by one screen in Excel press ---- key. 

a) Page Down   

       b) Page Up 

       c) Shift + Tab 

       d)  Shift + Up arrow 

14. ----- is the short cut key to quit from Excel. 

       a)  Alt + F1 

       b) Alt + F2 

       c) Alt + F3 

d) Alt + F4 

15. To insert a row, press rows command from the ---- menu. 

       a)  File 

       b)  Edit 

       c) Insert 

       d) View 

16. Click the ------- button on the standard tool bar to create a chart.      

      a) Pie Chart  

       b) Bar Chart 

       c) Chart Wizard 

       d) Wizard 



17. To display the current date, press --------. 

       a)  = Today ( )  

       b) Today ( ) 

       c) = Today 

       d) = Today ( D )  

18. ------ calculates the absolute value of a number. 

       a)  ACCURATE ( ) 

       b) = ACCURATE ( ) 

       c)  = ABSOLUTE ( ) 

d) = ABS ( ) 

19. MOD function calculates the ---- of two values.  

       a)  Quotient 

       b)  Remainder 

       c) Half 

       d) Double 

20. --------- enables the user to specify the simple criteria.  

       a)  Filter 

       b)  Auto Filter 

       c)  Advanced Filter 

       d)  Both b) and c) 

UNIT – III 

21. ------- is PowerPoint software. 

 a) Ms - Word 

       b) Ms - Excel 

       c)  Ms - PowerPoint 

       d) Ms - Access 

22. ------- view is the main editing view through which we can write and design our 

presentations. 

 a) Normal 



       b) Outline 

       c) Slide Sorter 

       d) Notes Page 

23. Which file format can be added to a PowerPoint show ? 

a)  .jpg 

 b) .gif 

 c)  .wav 

 d) All of the Above 

24. The --------- view displays miniature versions of the slides in one particular place. 

a) Normal 

       b) Outline 

       c) Slide Sorter 

       d) Notes Page 

25. ------ view takes up the full computer screen of the text or graphics. 

 a) Normal 

       b) Outline 

       c) Slide Sorter 

       d) Slide show  

26. Select the new slide option from the ------ menu, to insert a new slide.   

 a) Edit 

       b) Insert  

       c) Format  

       d) Slide Show 

27. To make the duplicate copy of the current slide, press ----- short cut keys. 

 a) Ctrl + Shift + C 

       b) Ctrl + Shift + X 

       c) Ctrl + Shift + V 

d) Ctrl + Shift + D 

28. To put numbering for our slides choose ------- menu.  



 a) Edit 

       b) View 

       c) Format  

       d) Slide Show 

29. The user can use the diagramming tool on the ------ tool bar to create an organisation 

chart. 

 a) Menu  

       b) Standard 

       c) Formatting 

d) Drawing 

30. Slide transitions in PowerPoint are the ------ movements as one slide changes to another 

during a presentation.  

 a) Visual 

       b) Virtual 

       c) Imaginary 

       d) Action 

UNIT – IV 

31.  --------- is a pathway that carries the information from sender to receiver. 

      a) Encyclopaedia 

       b) Trans Media  

 c) Transmission Media 

       d) Wikipedia 

32. Twisted pair cable is an example of -------- transmission media. 

      a) Bound 

       b) Wireless 

       c) Unguided  

       d) Unbound 

33. A protocol is a set of ------- for communicating data. 

 a) Fact 



       b) Ideas 

       c) Truth 

d) Rules and Guidelines 

34. WPANs stand for -----------------. 

       a)  Wired Personal Area Networks 

       b)  Wireless Person Application Networks 

       c) Wireless Personal Area Networks 

       d)  Wireless Personal Application Networks 

35. --------- is a malicious practice employed by cyber scammers and hackers to deceive 

(Mislead) systems, individuals, and organizations into perceiving something to be what it is 

not. 

 a) Application 

       b) Phishing 

       c) Spoofing 

       d) Content-Injection Phishing  

36. The Confidentiality, Integrity, and Availability are the goals of --------------. 

 a) E-commerce Security 

       b) Threats 

       c) Transmission 

       d) Protocol 

37. ------- keep data pure and trustworthy by protecting system data from intentional or 

accidental changes.  

  a) Vulnerability 

        b) Daniel of Servive 

        c) Integrity Models 

        d) Elevation of Previlege 

38. A ------- refers to a new or newly discovered incident with the potential to do harm to a 

system or your overall organization.  

 a) Threat 

       b) Data 



       c) Exchange 

       d) Protocol 

39. A ------ refers to a known weakness of an asset (resource) that can be exploited by one or 

more attackers. 

 a) Vulnerability 

       b) Threats 

       c)  Dumpster Diving 

       d) DOS 

40. A --------- is a security event that occurs when an attacker prevents legitimate users from 

accessing specific computer systems, devices, services or other IT resources. 

 a) Elevation of Privilege 

       b) Information Disclosure 

       c) Repudiation 

 d) Denial-of-Service Attack 

UNIT – V 

41. Authentication technology provides ---------- for systems by checking to see if a user's 

credentials match the credentials in a database of authorized users or in a data authentication 

server. 

 a) Input Control 

       b) Output Control 

       c) Data Control 

       d) Access Control 

42. 2FA stands for --------. 

a) Two Factor Authentication 

b) Two Factor Application 

c) Two Factor Authority 

d) Two Factor Application Layer 

43. A --------- is a string of characters used to verify the identity of a user during the 

authentication process. 

 a) Word 



       b) Text 

c) Password 

       d) Security 

44. Information should not be accessible to an unauthorized person. It should not be 

intercepted during the transmission is called -------. 

 a) Integrity 

       b) Authenticity 

       c) Confidentiality  

       d) Availability 

45. Network security is manifested in an implementation of security ------ and software. 

 a) Hardware 

       b) Motherboard 

       c) Keyboard 

       d) Mouse 

46. ----------- is any activity designed to protect the usability and integrity of your network 

and data. 

 a) Information Security 

       b) Web Security 

       c) Application Security 

d) Network Security 

47. IPS stands for --------. 

 a) Integrated Prevention System 

       b) Intrusion Protocol System 

       c) Intrusion Prevention System 

       d) Intrusion Prevention Security 

48. XSS denotes ------------. 

a) Cross-site Scripting  

b) Cut-site Scripting 

c) Xexox-Site Scripting 



d) Cross-site Security 

49.  Forensic investigators typically follow a standard set of -------. 

a) Rules 

 b) Regulations 

 c) Both a) and b) 

 d) Procedures 

50. Steganography is an encryption ------- that can be used along with cryptography as an 

extra-secure method in which to protect data. 

a) Technique 

 b) Program 

 c) Software 

 d) Hardware 

 



UNIT – I 

51. What is word processing? 

Word processing refers to typing, editing and formatting of any kind of document 

which could be a letter, memorandum, balance sheet etc., 

52. What is the short cut key used for creating a document in Ms-word? 

The Crtl + N are the short cut keys for creating a new document. 

53. Which keys are pressed to go to the previous word?  

Ctrl + Left Arrow are the keys used for to go to the previous word. 

54. What is the short cut key used to delete the character to the left of the cursor position?  

Backspace is the key deletes the character to the left of the cursor. 

55. What is the short cut keys used for cut the text? 

Ctrl + X are the short cut keys used for cut the text. 

56. List any three fonts available in Ms-Word? 

a) Times in New Roman b) Ariel c) Ariel Narrow 

57. How will you find the text in Ms-Word? 

The main use of this command is to position the cursor at a specific word for the purpose 

of editing. 

i) Open the Edit menu and click Find command 

ii) Press Ctrl +F keys for finding the text in Word. 

58. How do you put bullets and numbering option in Word? 

      i) Go to the Format menu and select Bullets and Numbering command 

      ii) A dialog box will be displayed. From that select the needed bullet and numbering 

style. 

 59. What is header? 

The header is a special text that is printed at the top of each page. 

Open the View menu and choose Header and footer command from the menu to put 

page number or text in the required 

60. What is mail merge?  

Mail merge consists in combining mail and letters and pre-addressed envelopes or 

mailing labels for mass mailings from a form letter. Microsoft Word can insert content from a 

database, spreadsheet or table into word documents.  

UNIT – II 



61. What is Excel? 

Microsoft Excel is a software program included in the Microsoft Office suite. It is 

used to create spreadsheets, which are documents in which data is laid out in rows and 

columns — like a big table 

62. What is meant by Active cell? 

An active cell refers to a cell in Excel spreadsheet that is currently selected by 

clicking mouse pointer or keyboard keys and only one cell can be an active cell at a time. An 

active cell is bounded by a heavy border around it. 

63. What is the use of Tab key in Excel? 

In Excel, different keys have different purposes when it comes to navigating around 

your worksheet. Normally, when you press the Tab key you will notice that Excel moves the 

cell cursor one column to the right. 

64. What is meant by range? 

Range refers to one particular cell or group of cells. 

65. What is the command used for resaving a work book? 

Go to File menu and click Save as Command. 

66. How do you erase the part of a worksheet? 

Select the particular cell or cells 

Right click the mouse and choose Delete option 

 

67. What is the use of Auto Fit selection command?  

Excel's AutoFit feature is designed to automatically resize cells in a worksheet to 

accommodate different sized data without having to manually change the column width and 

row height. 

68. What is the formula for displaying current date? 

= TODAY ( ) 

69. What is the use of COUNT command in Statistical function? 

The Count function is a statistical function. The function helps count the number of 

cells that contain a number, as well as the number of arguments that contain numbers. It will 

also count numbers in any given array. It was introduced in Excel in 2000. 

70. How do you change the Row height? 

ü Select the column or columns that you want to change. 

ü click Format menu. 

ü Under Cell Size, click Column Width. 

ü In the Column width box, type the value that you want. 



ü Click OK. 

UNIT – III 

71. List out any two slides in Power Point. 

i) Title Slide ii) Tittle Only iii) Content with Caption iv) Picture With Caption 

72. List any two advantages of using Power Point. 

ü With the help of PowerPoint the user can create the slides on quick and easy. 

ü It can reduce complicated messages to simple bullet points. 

ü It is easy to create a colourful and attractive design by using the standard templates 

and themes. 

73. Which PowerPoint feature allows the user to create a simple presentation quickly? 

AutoContent Wizard is used to create simple presentations quickly. 

74. What is normal view in PowerPoint? 

Normal view is also known as Slide View and offers a full size view of a slide, 

making it easier to create and edit slides.  

75. What is slide sorter view? 

Slide Sorter view is a feature included in Microsoft PowerPoint software that allows 

the user to see all the slides in a presentation at one time. Slide Sorter view provides the user 

with the ability to select several slides at one time.  

76. How do you insert a ClipArt to your presentation? 

Clip Art is a collection of media files (images, videos, audio, and animation files) that 

Microsoft includes with the PowerPoint application.  

Steps 

i) Click in the slide where you want to insert a clip art file. 

ii) On the Insert tab, in the Images group, click Online Pictures.  

iii) In the Insert Pictures dialog box (Clip Art task pane in PowerPoint 2007/2010), 

enter your search terms in the Bing.com field and press Enter.  

iv) Locate the clip art you want to insert in your slide and double-click on it or click 

the item. 

 

77. What is database? 

Database is a systematic collection of data. Databases support storage and 

manipulation of data. Databases make data management easy. 

78. What are the types of relationship in access? 

There are four types of relationships in access. 



ü One to one 

ü One to many 

ü Many to one 

ü Many to many 

79. What is query in access? 

A query is a request for data results, and for action on data. You can use a query to 

answer a simple question, to perform calculations, to combine data from different tables, or 

even to add, change, or delete table data. 

80. What is form in access?  

A form is a database object that you can use to enter, edit, or display data from a table 

or a query. You can use forms to control access to data, such as which fields of data are 

displayed. 

UNIT – IV 

81. List the types of transmission media. 

i) Wired or Guided Media or Bound Transmission Media 

ii) Wireless or Unguided Media or Unbound Transmission Media 

82. What is protocol? 

'Protocols' are developed by industry wide organizations. All data of protocols are 

stored in binary information. Protocol language is a mixture of bits, characters, integers, etc. 

Each of it has its own access method of exchanging data over a computer network, such as 

LAN, Internet, Intranet, etc. 

83. What is transmission control protocol? 

Transmission control protocol is used for communication over a network. In TCP data 

is broken down into small packets and then sent to the destination 

84. What is Phishing? 

Phishing is the fraudulent attempt to obtain sensitive information such as usernames, 

passwords and credit card details, often for malicious reasons, by disguising as a trustworthy 

entity in an electronic communication. 

85. List the two types of types of spoofing attacks. 

i. ARP Spoofing Attack 

ii. DNS Spoofing Attack 

iii. IP Spoofing Attack 



iv. Denial of Service attack 

 

86. What is meant by dumpster? 

Dumpster diving is a technique used to retrieve information that could be used to 

carry out an attack on a computer network.   

87. What are integrity goals? 

Integrity models have three goals: They are as follows. 

ü Prevent unauthorized users from making modifications to data or programs 

ü Prevent authorized users from making improper or unauthorized 

modifications 

ü Maintain internal and external consistency of data and programs 

88.What is meant by DNS Spoofing Attack? 

The Domain Name System (DNS) is responsible for associating domain names to the 

correct IP addresses. When a user types in a domain name, the DNS system corresponds that 

name to an IP address, allowing the visitor to connect to the correct server. 

89. List the types of threats. 

There are three main types of threats – natural threats (e.g., floods or a tornado), 

unintentional threats (such as an employee mistakenly accessing the wrong information) and 

intentional threats. There are many examples of intentional threats including spyware, 

malware, adware companies or the actions of a disgruntled employee. 

89. What is meant by Wireless MAN? 

Wireless Metropolitan Area Networks are a type of wireless network that connects 

several wireless LANs. 

90. Expand GAN. 

GAN stands for Global Area Network. 

UNIT – V 

91. What is MobileAuthentication? 

Mobile authentication is the process of verifying user via their devices or verifying 

the devices themselves. This lets users log into secure locations and resources from 

anywhere. The mobile authentication-n process involves multifactor authentication that can 

include one-time passwords, biometric authentication or QR code validation. 

 

92. What is inherence factor? 



The inherence factor is typically based on some form of biometric identification, 

including finger or thumb prints, facial recognition, retina scan or any other form of biometric 

data. 

93. What is PIN?  

PIN denotes Personal Identification Number.  

94. What is Confidentiality in E-commerce security? 

 Information should not be accessible to an unauthorized person. It should not be 

intercepted during the transmission. 

95. What is Firewall? 

Firewalls put up a barrier between your trusted internal network and untrusted outside 

networks, such as the Internet. They use a set of defined rules to allow or block traffic. A 

firewall can be hardware, software, or both.  

96. What is Software security? 

Software security is an idea implemented to protect software against malicious attack 

and other hacker risks so that the software continues to function correctly under such 

potential risks. Security is necessary to provide integrity, authentication and availability. 

98. What is Cross-site Scripting? 

Cross-site Scripting (XSS) is a client-side code injection attack. The attacker aims to 

execute malicious scripts in a web browser of the victim by including malicious code in a 

legitimate web page or web application. 

99. What is CSRF? 

Cross-Site Request Forgery (CSRF) is an attack that forces an end user to execute 

unwanted actions on a web application in which they're currently authenticated. 

100. What is SQL Injection? 

SQL Injection (SQLI) is a type of an injection attack that makes it possible to execute 

malicious SQL statements. 

K3 LEVEL 

 



 

K3 LEVEL 

UNIT – I 

1. List the advantages of using MS-Word. 

2. How do you create and save a document in Word.  

3. How do you open and print a document in MS-Word. 

4. What are the ways available in MS-Word to delete a particular text? 

5. Write the use of Bold, Underline Options in MS-Word. 

6. Write a note on Find and Replace command. 

7. Explain about the usage of Header and Footer in Word. 

8. Describe the use of Spelling and Grammar command in MS-Word. 

9. Explain the applications of Thesaurus in Word. 

10. How do you insert a row and column in Table in Word? 

UNIT – II 

11. Write a short note on Excel screen. 

12. What is Cell and Cell Address? 

13. How do you close work book in Ms-Excel? 

14. What is the use of Undo and Redo actions in Excel? 

15. How do you insert a row in Excel? 

16. How do you insert a column in Excel? 

17. How do you delete rows and columns in Excel? 

18. How do you align the data using Formatting Tool Bar? 

19. How to do you apply date and time in Excel? 

20. Write a note on naming ranges. 

UNIT – III 

21. Explain the advantages of using Power Point. 

22. Explain the variety of slides in Power Point. 

23. How will you create a new slide in Power Point? 

24. Explain the ways to create a slide. 



25. How will you see all the slides at a time? 

26. Explain the advantages of Notes Page view. 

27. How will you record a voice in Slide? 

28. How will you run a slide show in monitor? 

29. Write a note on animation. 

30. How will you insert a picture to your presentation? 

UNIT – IV 

31. Explain the types of transmission media. 

32. Write a note on the types of protocol. 

33. Explain about Transport layer of TCP/IP reference model. 

34. Discuss Wireless PAN. 

35. Explain Wireless Ad Hoc Network. 

36. Write a short note on Wireless WAN. 

37. Write a note on Spoofing. 

38. Explain Impersonal Attack 

39. Explain about Dumpster Diving. 

40. Explain about Vulnerability. 

UNIT - V 

41. Write a short note on Authentication factors. 

42. Write the steps to createa Secured Password. 

43. Following are the essential requirements for safe e-payments/transactions − 

      windows security. 

44. Write note on Firewall. 

45. Bring out the types of software security. 

46. List out the types of network security. 

47. Explain about Cross Site Forgery. 

48. How the SQL Injection attack performed? 

49. Write a note on Computer Forensics. 

50. Write a short note on Steganography. 



 



K4 AND K5 LEVEL 

UNIT – I 

1. Explain the various ways to edit a document. 

2. Explain the following. 

i) Cut and Paste ii) Copy and Paste 

3. Describe the formatting of text in different ways? 

4. Explain the various steps in Mail Merge command in Ms-Word. 

5. Discuss the various procedures in Table creation in Word. 

UNIT – II 

6. Explain the various methods to format a cell in Excel. 

7. Explain various Statistical and Maths functions in Ms-Excel.  

8. Describe the process of Chart creation in Excel. 

9. Explain the usage of Auto Filter command in Excel.  

10. Discuss the advantage of using Advanced Filter. 

UNIT – III 

11. Explain the various Power Point Views. 

12. Explain the creation and running of a slide in Power Point? 

13. Explain custom animation in detail. 

14. Explain the following. 

i) Tables 

ii) Queries 

15. Explain the following. 

i) Forms 

ii) Reports 

UNIT – IV 

16. Explain the components of communication system process. 

17. Discuss about the TCP/IP reference model. 

18. Describe the types of wireless networks. 

19. Explain the types of cyber attacks. 



20. Explain the various types of spoofing attacks. 

UNIT – V 

21. Explain in detail about authentication methods.  

22. Describe E-commerce security. 

23. Explain about Windows security.  

24. Discuss about Network security. 

25. Explain about Software security 

******* 

 


